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Abstract

Coxiella burnetii is the causative agent of human Q fever, a zoonotic disease that can cause a 

debilitating, flu-like illness in acute cases, or a life-threatening endocarditis in chronic patients. An 

obligate intracellular bacterial pathogen, Coxiella survives and multiplies in a large lysosome-like 

vacuole known as the Coxiella parasitophorous vacuole (CPV). A unique characteristic of the 

CPV is the acidic environment (pH ~5.0), which is required to activate Coxiella metabolism and 

the Coxiella type 4 secretion system (T4SS), a major virulence factor required for intracellular 

survival. Further, inhibiting or depleting vacuolar ATPase, a host cell protein that regulates 

lysosomal pH, inhibits intracellular Coxiella growth. Together, these data suggest that CPV pH 

is an important limiting factor for Coxiella growth and virulence. This unit describes a method 

to determine CPV pH using live cell microscopy of a pH–sensitive fluorophore conjugated to 

dextran. This technique is useful to measure changes in CPV pH during infection or in response to 

drug treatment.
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INTRODUCTION

Following internalization by the host cell, Coxiella resides in a tight-fitting nascent 

phagosome that progresses through the default endocytic pathway (Heinzen, Scidmore, 

Rockey, & Hackstadt, 1996). At about one to two days post-infection, the CPV expands 

through fusion with late endosomes, lysosomes, and autophagosomes (Voth & Heinzen, 

2007), acquiring late endosomal proteins CD63 and Rab7 (Berón, Gutierrez, Rabinovitch, & 

Colombo, 2002; Ghigo et al., 2002), lysosomal-associated membrane protein 1 (Lamp1) 

(Heinzen et al., 1996), and autophagic proteins LC3 and Rab24 (Berón et al., 2002; 

Gutierrez et al., 2005). A key characteristic of the CPV lumen is that it is acidic in nature, 

with a pH of ~5.0 (Akporiaye, Rowatt, Aragon, & Baca, 1983; Grieshaber, Swanson, 

& Hackstadt, 2002; Hackstadt & Williams, 1981; Maurin, Benoliel, Bongrand, & Rault, 

1992). When the CPV pH becomes more basic by treatment with lysomotropic amines 

or the vacuolar ATPase inhibitor bafilomycin A, Coxiella growth is significantly blocked 

(Hackstadt & Williams, 1981; Heinzen et al., 1996). Coxiella glucose and glutamate 

transport and catabolism is most active between pH 2.0 and 5.5 (Hackstadt & Williams, 

1981), and a recently developed axenic medium supports Coxiella growth at pH 4.75 

(Omsland et al., 2009). In addition to activating bacterial metabolism, CPV acidification 
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triggers the Coxiella type 4 secretion system (T4SS) (Newton, McDonough, & Roy, 2013), 

a major bacterial virulence factor which translocates Coxiella effector proteins into the host 

cell cytosol where they manipulate host cellular processes. Given the importance of CPV 

acidification, accurately measuring CPV pH is essential to better understand development of 

the Coxiella intracellular niche.

This unit describes a ratiometric fluorescent microscopy approach to measure CPV pH using 

pH-sensitive and pH-insensitive fluorophores conjugated to dextran. Dextran is internalized 

by host cells through fluid phase endocytosis and delivered to the CPV by CPV-endosome 

fusion (Heinzen et al., 1996), providing an efficient method of labeling the CPV lumen. The 

Basic Protocol describes labeling and imaging of Coxiella-infected cells with fluorescent 

dextrans, including experimental samples and standards for the pH calibration curve. Data 

analysis is described in Support Protocol 1, with set up of the live cell imaging chamber in 

Support Protocol 2.

BASIC PROTOCOL

IMAGING OF FLUORESCENT DEXTRAN IN THE CPV

Oregon Green, a fluorinated analog of fluorescein (Sun, Gee, Klaubert, & Haugland, 1997), 

has a pKa of 4.7, making it more suitable than fluorescein (pKa of 6.4) to measure the 

acidic pH of the CPV (Johnson, Ostrowski, Jaumouillé, & Grinstein, 2016). Once delivered 

to the CPV lumen via fusion with dextran-loaded endosomes, Oregon Green fluorescent 

intensity will vary depending on the CPV pH. In contrast, Alexa647 fluorescent intensity 

is pH-insensitive (Chen, Cheng, Behlke, & Tsourkas, 2008). The Oregon Green/Alexa647 

fluorescent intensity ratio is compared to a standard curve to calculate the pH of individual 

CPVs. The standard curve is prepared by treating infected cells with the ionophores 

monensin and nigericin, which allows the intracellular pH (including the CPV) to equilibrate 

with an extracellular buffer of known pH. The effect of drug treatment, host gene knock 

down, protein overexpression, or bacterial mutation on the CPV pH can be measured to 

determine a role in the establishment or maintenance of CPV pH.

In this protocol, wild-type Coxiella expressing mCherry red fluorescent protein (mCherry-

Coxiella) is used to infect HeLa cells, allowing for efficient identification of bacteria-

containing CPVs. The protocol is also applicable to other cell types, although infection 

and dextran labeling conditions may need to be optimized. This protocol uses Leica DMI 

6000B inverted microscope with 63× oil immersion objective and the TOKAI HIT INU 

series stage top incubator for environmental control. However, other microscope systems can 

also be used as long as required filters are available.

Materials

Dextran working solution (see recipe)

Complete RPMI-1640 culture medium (with 10% fetal bovine serum)

HeLa cells infected with mCherry-Coxiella and plated on ibidi μ-Slides (Support Protocols 1 

and 3, Winfree & Gilk, 2017, UNIT 6C.2)
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Phosphate-buffered saline (PBS; HyClone, GE Healthcare Life Sciences, cat. no. 

SH3025601), sterile

Ionophore working solution (see recipe)

pH standards (see recipe)

Water bath

Sterile biosafety cabinet

CO2 incubator for tissue culture

200-μl pipette and sterile tips

TOKAI HIT INU series stage top incubator (see Support Protocol 1)

Leica DMI 6000B inverted microscope with 63X oil immersion objective lens

Preparing the samples for microscopy

1. Warm the complete RPMI 1640 culture medium and dextran working solution to 

37°C in a water bath.

2. In a sterile biosafety cabinet, remove medium from each channel of the μ-Slide 

with a 200-μl pipette, and replace with 50 μl of the dextran working solution.

Consult the manufacturer’s instructions and Support Protocol 3 of 

Winfree and Gilk, 2017 (UNIT 6C.2) for details on working with ibidi 

μ-Slides. We typically use one μ-Slide for the standard curve, and a 

second μ-Slide for experimentals.

Stagger the labeling start time for multiple μ-slides (e.g., standards and 

experimentals) to avoid overloading cells with dextran. We typically 

use a 4-hr stagger between the standard and experimental samples. 

For example, dextran is added to standard samples at 8 a.m. and 

experimentals at noon. Noon to 4 p.m. is utilized to image the standard 

curve, with imaging of the experimentals at 4 p.m.

3. Incubate the μ-Slide for 4 hr in 37°C, 5% CO2 tissue culture incubator.

4. Wash each channel of the μ-Slide at least four times, each time with PBS.

To avoid additional internalization and increased variability between 

samples, it is crucial to wash off all the extracellular dextran. With 

a 200-μl pipette, carefully remove the medium from the far reservoir. 

Then add 120 μl of PBS to the near reservoir. Repeat four times, or until 

all the bluish-green dextran has been removed.

5. After the final wash, replace PBS with 120 μl pre-warmed RPMI 1640 culture 

medium in each channel.
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This will prevent flexing of μ-slides that occurs with temperature 

fluctuations, which can affect stability of imaging.

Imaging the standard samples

6. Replace the culture medium with 120 μl ionophore working solution (pre-

warmed) in the first channel of the μ-Slide.

7. Incubate in the live cell chamber attached to the microscope for 5 min.

8. Replace the ionophore working solution in the first channel with 120 μl of pH 

standard 7.0 (pre-warmed) and incubate for 5 min.

9. Using the red filter of the microscope, identify CPVs by focusing on mCherry-

Coxiella.

It is critical not to use green (Oregon Green) or far red (Alexa647) 

filters at this point, as prolonged exposure in these channels will bleach 

the fluorescent signal and affect final measurements.

10. Switch to the green filter and empirically determine the exposure setting. Repeat 

for two more CPVs to determine the best exposure settings for Oregon Green.

As Oregon Green is most fluorescent at pH 7.0, the exposure settings 

should be determined for the pH 7.0 standard and kept constant for the 

remainder of the experiment.

11. Switch to the far red filter and determine exposure settings for Alexa647, as 

described in step 10. These settings should be used for the remainder of the 

experiment.

12. Switch to red filter and identify a new CPV based on mCherry-C.burnetii. Image 

both the green and far red channels using the exposure settings determined in 

steps 10 and 11.

13. Repeat step 12 for at least 30 total CPVs in the first channel of the μ-slide.

CPVs used to determine exposure settings should not be used for 

measurements in the standard curve.

14. Move over to the next channel of the μ-Slide, and repeat steps 6–8, 12, and 13 for 

pH standard 6.0.

15. Repeat for all the channels of the μ-slide using pH standard 5.5 for the third 

channel, pH standard 5 for the fourth channel, pH standard 4.5 for the fifth 

channel and pH standard 4 for the sixth channel.

16. Carefully save all the images with appropriate annotation for analysis purpose 

(Support Protocol 2).

Keep images organized by pH standards used. Separate folders for each 

pH standard will simplify the image analysis process.
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Imaging the experimental samples

17. Label infected HeLa cells in the second μ-Slide with dextran as in steps 1 to 5.

Use the second μ-Slide with mCherry-Coxiella-infected HeLa cells for 

experimental samples (e.g., control and treatment conditions).

18. Perform steps 12 and 13 for each channel, using the capture settings used for the 

pH standards.

19. Carefully save all the images with appropriate annotation for analysis purpose 

(Support Protocol 2).

SUPPORT PROTOCOL 1

SET UP OF TOKAI HIT INU STAGE TOP INCUBATOR FOR LIVE-CELL MICROSCOPY

During live-cell microscopy, cells are maintained in their normal growth conditions, 

including 37°C, 5% CO2, and ~75% humidity using specially designed chambers attached 

to the stage of the microscope. The chamber is connected to a control unit, where the 

investigator can set the desired temperature and percentage of CO2. This protocol describes 

imaging cells in μ-Slides using a chamber slide adapter in a TOKAI HIT INU series stage 

top incubator connected to a TOKAI HIT INU control unit. The lid of the live-cell chamber 

and the stage are heated to avoid condensation. To precisely maintain the tissue culture 

media at 37°C, a metal lid with a sterile feedback sensor is placed on top of the μ-Slide, 

and the feedback sensor is immersed in the media. An objective heater is used to minimize 

heat dispersion through the objective. CO2 is supplied from commercial CO2 tank connected 

to the control unit, and incubator humidity is maintained by adding deionized sterile water 

to the designated water channel around the edge of the incubator. The water channel is also 

heated to facilitate humidification.

Materials

Sterile deionized water

70% ethanol

Leica Microsystems 3P immersion oil Type F

TOKAI HIT INU series stage top incubator and TOKAI HIT INU temperature and gas-

mixer control unit (Fujinomiya, Japan)

μ-Slide VI0.1 (Ibidi, cat. no. 80666)

TOKAI HIT CSG1–200F sensor lid for chamber slides (Fujinomiya, Japan)

Set up of stage top incubator for equilibration

1. Place the TOKAI HIT INU series stage top incubator on the stage of the Leica 

DMI 6000B microscope.
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2. Removing the lid of the incubator chamber, add 15 ml sterile deionized water to 

the designated water bath.

The water level should be below the CO2 supply channel opening.

3. Install objective heater on 63× oil immersion objective lens and heat to 37°C by 

connecting the wire of the objective heater to the control unit.

4. Install the appropriate adapter for chamber slides in the incubator chamber.

5. Place a μ-Slide with sterile deionized water in the channels in the chamber slide 

adapter.

This μ-Slide is used for equilibration of the chamber, and can be saved 

and used in future experiments.

6. Remove the plastic lid of the μ-Slide and install the TOKAI HIT CSG1–200F 

sensor lid for chamber slides on the μ-Slide, ensuring its stability using the two 

flat springs of the chamber slide adapter. Place the sensor wire into one of the 

reservoirs of the ibidi μ-Slide.

Sterilize the feedback sensor wire of the sensor lid by wiping with 70% 

ethanol before placing it on the μ-Slide. While placing the sensor lid, 

ensure that the feedback sensor wire is immersed in the water.

7. Connect the wire of the sensor lid to the designated port (refer to manufacturer’s 

instructions).

8. Replace the lid of the incubator chamber.

Set up of the control unit

9. On the control unit, press the main power button and turn on the “Mix Gas 

Power,” “Sample Temp,” and “Lens Power” switches.

10. Set the “Top Heater,” “Bath Heater,” “Stage Heater,” “Lens Heater,” and 

“Sample Temp” gauges to 37°C, and set “CO2 concentrator” gauge to 5%.

11. Wait for at least 1 hr for the incubator chamber to equilibrate.

Installation of sample slide

12. Carefully remove the lid of the incubator chamber.

13. Remove the flat springs of the chamber slide adapter, and remove the sensor lid.

While removing the sensor lid, ensure not to touch the feedback sensor 

wire to avoid contamination.

14. Remove the μ-Slide with water.

15. Add a drop of Leica Microsystems 3P immersion oil Type F on the objective 

lens.

16. Place the μ-Slide with infected HeLa cells in the chamber slide adapter.
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17. Replace the sensor lid and carefully immerse the feedback sensor wire into the 

culture medium in one of the near reservoirs of the μ-Slide. Ensure the stability 

of the sensor lid with the two flat springs.

18. Replace the lid of the incubator chamber, and proceed to the Basic Protocol.

SUPPORT PROTOCOL 2

ANALYSIS OF THE IMAGE DATASETS

Images acquired at steps 16 and 19 of the Basic Protocol are analyzed using the open-source 

imaging analysis software FIJI (Schindelin et al., 2012), and plotted with the graphing 

software Prism (GraphPad). FIJI software can open and analyze most imaging files via 

Bio-Formats. Moreover, FIJI is supported by both Windows and Macintosh platforms.

Materials—FIJI, Version 2.0.0-rc-59/1.51j with Java 8 installed for your computer platform 

(http://imagej.net/Downloads)

Digital datasets from microscope

Excel (Microsoft) or another spreadsheet software

Prism (GraphPad) or other graphing software

Measurement of fluorescent intensities of the CPVs in FIJI

1. Open dataset in FIJI a “File” : “Open” → “Bioformats” → “Dataset file name.”

This will open “Bioformats Series Options” window. Select the images 

you want to analyze. Click OK.

2. Perform a background subtraction: “Process” → “Subtract Background . . . ” 

with a radius of 50 pixels and process all images in stack when asked by the 

“Process Stack?” dialog window.

50 pixels is an average of the smallest and largest CPVs that are 

found in HeLa cells with these infection conditions at three days 

post infection. With different cell lines, and with different infection 

conditions the pixel diameter for background subtraction need to be 

adjusted.

3. Open “Analyze” → “Set Measurements . . . ” and select “Mean gray value.”

4. Draw a “region of interest” (ROI) around the CPV in green channel.

Use “oval,” “polygon selections.” or “freehand selections” tool to draw 

an ROI around the CPV. Use different drawing tools based on the shape 

of the CPV. Extreme precision in drawing the ROI is not required, as the 

fluorescent intensity of Oregon Green will be normalized to Alexa647 

fluorescence within the ROI.
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5. Open “Analyze” → “Tools” and select “ROI Manager . . . ” Add the selection to 

the “ROI Manager” by selecting “Add” in the “ROI Manager” window.

“ROI Manager” saves the “ROI” for future use. If accidently removed, 

the ROI can be recovered by clicking on the selection in the “ROI 

Manager.”

6. In the Oregon Green channel, record the fluorescent intensity of the ROI by 

pressing the “M” key.

This generates a results window. The values in the “Mean” column is 

the average fluorescent intensity of all the pixels in the CPV.

7. Switch to the Alexa647 channel by scrolling the bottom bar to the right. Bring 

back the same ROI (if not already there) and press ‘M’ key to record the 

fluorescent intensity of the Alexa647 in the same CPV.

Determination of ratio of fluorescent intensities in Excel

8. Record the mean fluorescent intensities of the Oregon Green and the Alexa647 in 

separate columns in Excel, preferably side by side.

9. Repeat steps 4–8 for both standard and experimental CPVs.

10. In Excel, calculate the ratio of mean intensities of Oregon Green and Alexa647 

for each CPV by dividing Oregon Green intensity by Alexa647 intensity.

Generation of standard curve and determination of the pH of experimental 
CPVs in Prism

11. Copy mean intensity ratio values of standards from Excel to “Prism” and arrange 

in columns: Open “Prism” → Select “Column” from the sidebar → Check 

“enter replicate values stacked into column.”

For example, label Group A as pH 7.0, Group B as pH 6.0, etc.

12. Calculate column averages, standard deviation and standard errors: Within the 

data sheet under Analysis on the toolbar, click → “Analyze” → “Column 

Analyses” → double click “Column Statistics” → in the “Parameters: Column 

Statistics” dialog box check “Mean, SD, SEM.” Click “Ok.”

This will create a “Col Stats of ...” sheet in the “Results” section.

13. In the “Col Stats” sheet, copy mean values, standard error of mean values (SEM), 

and number of values (N) for each standard.

14. From the drop-down menus, click “File” → “New” → “New Data Table (+ 

Graph)” → select “XY” from the sidebar → under Enter/import data: Y: select 

“Enter and plot error values already calculated elsewhere” → select “Mean, 

SEM, N” from the “Enter:” drop down menu.

15. Paste Mean, SEM, and N values generated in the “Col Stats” sheet under “Group 

A” and arrange in rows according to the pH standards in the “X” column. Put 

“pH” as “X title”.
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For example, in the first row, in the “X” column, type 7.0, and in group 

A, paste mean, SEM, and N values for pH 7 (see step 13) in respective 

columns. In the second row, type 6.0 in the “X” column and paste mean, 

SEM, and N values for pH 6 in respective columns and so on.

16. To interpolate the experimental samples to the standard curve, paste the ratio 

of mean intensities for the experimental samples, calculated at step 10, in the 

“Mean” column of group A of the same data sheet as in step 15.

17. Plot a non-linear regression curve (Boltzmann Sigmoidal) of the standards and 

interpolate ratio of mean intensities of the experimentals: Click “Analyze” → 
“XY analyses” → “Interpolate a standard curve” → OK → Select “Sigmoidal, 

4PL, X is log(concentration)” → Click “More” → In Nonlinear Regression 

parameters dialog box → Select classic equations → Boltzmann sigmoidal → 
Check “Interpolate experimentals from standard curve” → OK.

This will create a “Nonlin fit of . . . ” sheet in “Results” section 
containing a “Interpolated X values” sheet. These are the CPV pH 
values of the experimental samples.

18. Finally, copy the CPV pH values of the experimental samples and paste in a 

new data sheet arranged in columns, with each column being a condition (e.g., 

control or treatment). Perform column analyses as in step 12 to determine mean 

differences of the CPV pH between different conditions used.

REAGENTS AND SOLUTIONS

Use deionized, distilled water, unless otherwise noted.

Dextran solutions—Prepare a stock solution of Oregon Green-dextran (ThermoFisher 

Scientific, cat. no. D7171) by dissolving to a final concentration of 2 mg/ml in sterile 

phosphate-buffered saline (PBS; HyClone, GE Healthcare Sciences, cat. no. SH3025601). 

Prepare a stock solution of Alexa647-dextran (ThermoFisher Scientific, cat. no. D22914) by 

dissolving to a final concentration of 2 mg/ml in sterile PBS. To remove insoluble particles 

from dextran solutions, centrifuge for 2 min at 12,000 × g, 4°C. Transfer the supernatant 

into new sterile 1.5-ml microcentrifuge tubes as 100-μl aliquots, and store up to 6 months 

at −20°C protected from light. Immediately before use, prepare a dextran working solution 

by diluting both Oregon Green-dextran and Alexa647-dextran in warm culture medium to a 

final concentration of 0.5 mg/ml each, and vortex well. Centrifuge for 2 min at 12,000 × g, 

25°C, to pellet insoluble particles, and transfer to a new tube.

Ionophore solutions—Prepare a stock solution of nigericin sodium salt (Sigma Aldrich, 

cat. no. N7143) by dissolving in methanol to a final concentration of 10 mM. Prepare 

a stock solution of monensin sodium salt (Sigma Aldrich, cat. no. M5273) in methanol 

to a final concentration of 10 mM. Store ionophore stock solutions up to 3 years at 

−20°C. Immediately before use, dilute both ionophores in warm culture medium to a final 

concentration of 10 μM each, and vortex well.
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pH standards—Citrate or phosphate buffers of varying pH containing 10 μM of 

both nigericin sodium salt and monensin sodium salt are used as pH standards in this 

protocol. Refer to the APPENDIX B of Promega Buffers for Biochemical Reactions 

found at https://www.promega.com/resources/product-guides-and-selectors/protocols-and-

applications-guide/buffers-for-biochemical-reactions/ to prepare citrate buffers of pH 4, 4.5, 

5, and 5.5 and phosphate buffers of pH 6 and pH 7. Filter sterilize the pH buffers and store 

at room temperature. Immediately before use, add 10 μM of nigericin (10 μM final) and 

monensin (10 μM final) to all pH buffers to prepare pH standards.

COMMENTARY

Background Information

Following internalization by the host cell, the nascent Coxiella-containing phagosome 

matures through the host endocytic pathway, eventually fusing with host endosomes, 

autophagosomes, and lysosomes to form a large, fusogenic, lysosome-like vacuole (Heinzen 

et al., 1996). Despite the presence of active lysosomal hydrolases, Coxiella thrives in the 

acidic environment of the mature CPV (Heinzen et al., 1996; Howe, Shannon, Winfree, 

Dorward, & Heinzen, 2010). CPV acidification is at least partially due to the presence 

of vacuolar ATPase (V-ATPase) on the CPV membrane (Heinzen et al., 1996). V-ATPase 

is a multimeric protein responsible for lysosomal acidification, and either inhibiting V-

ATPase activity or depleting V-ATPase protein using siRNA blocked Coxiella growth 

(Heinzen et al., 1996; McDonough et al., 2013). This suggests that V-ATPase-mediated 

CPV acidification is essential for bacterial survival within the host cell.

Early studies suggested that the CPV pH is between 4.5 and 5.3 (Akporiaye et al., 1983; 

Grieshaber et al., 2002; Maurin et al., 1992). Coxiella metabolism is most active between pH 

4.5 and 4.9 in an axenic medium (Omsland, Cockrell, Fischer, & Heinzen, 2008), and CPV 

acidification is necessary for Coxiella T4SS-mediated secretion of bacterial proteins into 

the host cytoplasm (Newton et al., 2013). A recent study in CHO (Chinese Hamster Ovary) 

cells suggests CPVs exist in two heterogeneous populations, depending on CPV membrane 

integrity (Mansilla Pareja, Bongiovanni, Lafont, & Colombo, 2017). While the average CPV 

pH of the two populations was 5.68, intact CPVs had an average pH of 5.2, while a second 

population of damaged CPVs were more alkaline (>pH 6) (Mansilla Pareja et al., 2017). A 

recent study in HeLa epithelial cells and cholesterol-free fibroblasts found the average CPV 

pH to be 5.2, with acidification to pH 4.5 upon elevated cholesterol in the CPV (Mulye, 

Samanta, Winfree, Heinzen, & Gilk, 2017). Therefore, it appears that CPVs could have a 

wide range of luminal pH, though it is not clear how differences in technique and cell type 

contribute to this range of measurements. Careful studies are needed to determine how CPV 

pH changes during infection in different cell types, and elucidate both host and bacterial 

factors involved in establishing and maintaining CPV pH.

Given the importance of CPV pH to Coxiella pathogenesis and the wide range of published 

measurements, it is critical to accurately measure CPV pH during infection. One method 

is dual wavelength ratiometric measurement of either fluorescein or Oregon Green, a 

fluorescein derivative. This approach relies on a single fluorophore for both pH-sensitive 

and pH-stable fluorescence; the major drawback of using a single fluorophore is that 
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the reference (pH-insensitive) wavelength can be hampered by poor signal or underlying 

pH-sensitivity (Canton & Grinstein, 2015). Several studies used fluorescein to measure 

CPV pH; however, the higher pKa of fluorescein (6.4) makes it less accurate at acidic pH 

compared to Oregon Green (pKa 4.7). To measure CPV pH, the fluorophore is conjugated 

to dextran and delivered to the CPV by fluid-phase endosomes. CPVs are then imaged 

at both the pH-sensitive (490 nm) and a pH-insensitive (440 nm) excitation wave-lengths, 

with a common emission wavelength of 520 nm. To determine individual CPV pH, the 

490/440 fluorescent intensity ratio is compared to a calibration curve. The calibration curve 

can be generated in buffers of known pH; however, this overlooks cellular factors which 

could potentially affect intracellular fluorescence. A preferred method is to treat cells with 

ionophores, followed by bathing the cells in pH buffers prior to imaging. Dual wavelength 

imaging of Lysosensor yellow/blue DND-160 dye has also been used to measure CPV pH, 

though in this case the fluorophore is membrane-permeable and not restricted to endosomes 

or the CPV.

The method described in this protocol uses a second pH-insensitive fluorophore such as 

rhodamine or Alexa647 (Drecktrah, Knodler, Ireland, & Steele-Mortimer, 2006; Johnson 

et al., 2016). Using two separate fluorophores avoids overlap between the excitation wave-

lengths and potential pH-sensitivity of the reference wavelength. Similar to the single 

fluorophore method, an in situ calibration curve using ionophore-treated cells bathed in 

pH buffers is generated based on the Oregon Green/Alexa647 fluorescent intensity ratio. To 

avoid differential bleaching of the two fluorophores, the shortest exposure times possible 

must be used. In addition, because the Oregon Green and Alexa647 are not conjugated to the 

same dextran, this approach assumes equal trafficking of the two dextrans to the CPV over a 

period of four hours.

Critical Parameters

Refer to Winfree and Gilk (2017; UNIT 6C.2) for information on working with HeLa cells 

and Coxiella burnetii.

Anticipated Results

In infected HeLa cells and mouse embryonic fibroblast cells, we found the CPV pH to be 

5.2 under control conditions and statistically significant differences between control and 

experimental conditions (Mulye et al., 2017). Moreover, upon drug treatment the CPV pH 

decreased from 5.2 to 4.5 within 30 min post-treatment and stayed stable for 2 hr. Despite 

the range of CPV pH that is observed in control cells, this protocol can be used to determine 

subtle changes in CPV pH. Oregon Green fluorescence should change noticeably between 

pH 7 to pH 4 (e.g., Fig. 6C.3.1A). When the Oregon Green/Alexa647 ratio is plotted against 

pH, a standard curve similar to Figure 6C.3.1B should be obtained.

Time Considerations

A typical experiment examining pH at three days post infection would include plating and 

infecting HeLa cells on day 0, replating onto μ-Slides on day 2, and dextran labeling and live 

cell imaging on day 3. Dextran labeling of standard and experimental samples are staggered 

by 4 hr. In our experience, imaging the standards (six channels) takes about three hours, 
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while imaging the experimental samples with two control conditions and two treatment 

conditions takes about an hour. A set of three experiments, with staggered infected cells, 

standards, and experimental conditions can be completed within three weeks.

Acknowledgement

This work was supported by the American Heart Association (14SDG18420034).

Literature Cited

Akporiaye ET, Rowatt JD, Aragon AA, & Baca OG (1983). Lysosomal response of a murine 
macrophage-like cell line persistently infected with Coxiella burnetii. Infection and Immunity, 40, 
1155–1162. [PubMed: 6852916] 

Berón W, Gutierrez MG, Rabinovitch M, & Colombo MI (2002). Coxiella burnetii localizes in a 
Rab7-labeled compartment with autophagic characteristics. Infection and Immunity, 70, 5816–5821. 
doi: 10.1128/IAI.70.10.5816-5821.2002. [PubMed: 12228312] 

Canton J, & Grinstein S (2015). Measuring lysosomal pH by fluorescence microscopy. Methods in 
Cell Biology, 126, 85–99. doi: 10.1016/bs.mcb.2014.10.021. [PubMed: 25665442] 

Chen AK, Cheng Z, Behlke MA, & Tsourkas A (2008). Assessing the sensitivity of commercially 
available fluorophores to the intracellular environment. Analytical Chemistry, 80, 7437–7444. doi: 
10.1021/ac8011347. [PubMed: 18700780] 

Drecktrah D, Knodler LA, Ireland R, & Steele-Mortimer O (2006). The mechanism of Salmonella 
entry determines the vacuolar environment and intracellular gene expression. Traffic, 7(1), 39–51. 
doi: 10.1111/j.1600-0854.2005.00360.x. [PubMed: 16445685] 

Ghigo E, Capo C, Tung C-H, Raoult D, Gorvel J-P, & Mege J-L (2002). Coxiella burnetii survival 
in THP-1 monocytes involves the impairment of phagosome maturation: IFN-gamma mediates 
its restoration and bacterial killing. Journal of Immunology, 169, 4488–4495. doi: 10.4049/
jimmunol.169.8.4488.

Grieshaber S, Swanson JA, & Hackstadt T (2002). Determination of the physical environment within 
the Chlamydia trachomatis inclusion using ion-selective ratiometric probes. Cellular Microbiology, 
4, 273–283. doi: 10.1046/j.1462-5822.2002.00191.x. [PubMed: 12027956] 

Gutierrez MG, Vázquez CL, Munafó DB, Zoppino FCM, Berón W, Rabinovitch M, & Colombo 
MI (2005). Autophagy induction favours the generation and maturation of the Coxiella-replicative 
vacuoles. Cellular Microbiology, 7, 981–993. doi: 10.1111/j.1462-5822.2005.00527.x. [PubMed: 
15953030] 

Hackstadt T, & Williams JC (1981). Biochemical stratagem for obligate parasitism of eukaryotic cells 
by Coxiella burnetii. Proceedings of the National Academy of Sciences of the United States of 
America, 78, 3240–3244. doi: 10.1073/pnas.78.5.3240. [PubMed: 6942430] 

Heinzen RA, Scidmore MA, Rockey DD, & Hackstadt T (1996). Differential interaction with 
endocytic and exocytic pathways distinguish parasitophorous vacuoles of Coxiella burnetii and 
Chlamydia trachomatis. Infection and Immunity, 64, 796–809. [PubMed: 8641784] 

Howe D, Shannon JG, Winfree S, Dorward DW, & Heinzen RA (2010). Coxiella burnetii phase I 
and II variants replicate with similar kinetics in degradative phagolysosome-like compartments 
of human macrophages. Infection and Immunity, 78, 3465–3474. doi: 10.1128/IAI.00406-10. 
[PubMed: 20515926] 

Johnson DE, Ostrowski P, Jaumouillé V, & Grinstein S (2016). The position of lysosomes within 
the cell determines their luminal pH. Journal of Cell Biology, 212, 677–692. doi: 10.1083/
jcb.201507112. [PubMed: 26975849] 

Mansilla Pareja ME, Bongiovanni A, Lafont F, & Colombo MI (2017). Alterations of the Coxiella 
burnetii replicative vacuole membrane integrity and interplay with the autophagy pathway. 
Frontiers in Cellular and Infection Microbiology, 7, 112. doi: 10.3389/fcimb.2017.00112. 
[PubMed: 28484683] 

Samanta and Gilk Page 12

Curr Protoc Microbiol. Author manuscript; available in PMC 2023 February 02.

A
uthor M

anuscript
A

uthor M
anuscript

A
uthor M

anuscript
A

uthor M
anuscript



Maurin M, Benoliel AM, Bongrand P, & Rault D (1992). Phagolysosome of Coxiella burnetii - 
infected cell lines maintain an acidic pH during persistent infection. Infection and Immunity, 60, 
5013–5016. [PubMed: 1452331] 

McDonough JA, Newton HJ, Klum S, Swiss R, Agaisse H, & Roy CR (2013). Host pathways 
important for Coxiella burnetii infection revealed by genome-wide RNA interference screening. 
mBio, 4, 1–13. doi: 10.1128/mBio.00606-12.

Mulye M, Samanta D, Winfree S, Heinzen RA, & Gilk SD (2017). Elevated cholesterol in the Coxiella 
burnetii intracellular niche is bacteriolytic. mBio, 8, e02313–2316. doi: 10.1128/mBio.02313-16. 
[PubMed: 28246364] 

Newton HJ, McDonough JA, & Roy CR (2013). Effector protein translocation by the Coxiella 
burnetii Dot/Icm type IV secretion system requires endocytic maturation of the pathogen-occupied 
vacuole. PLoS One, 8. doi: 10.1371/journal.pone.0054566.

Omsland A, Cockrell DC, Fischer ER, & Heinzen RA (2008). Sustained axenic metabolic activity by 
the obligate intracellular bacterium Coxiella burnetii. Journal of Bacteriology, 190, 3203–3212. 
doi: 10.1128/JB.01911-07. [PubMed: 18310349] 

Omsland A, Cockrell DC, Howe D, Fischer ER, Virtaneva K, Sturdevant DE, . . . Heinzen RA (2009). 
Host cell-free growth of the Q fever bacterium Coxiella burnetii. Proceedings of the National 
Academy of Sciences, 106, 4430–4434. doi: 10.1073/pnas.0812074106.

Schindelin J, Arganda-Carreras I, Frise E, Kaynig V, Longair M, Pietzsch T, . . . Cardona A (2012). 
Fiji: An open-source platform for biological-image analysis. Nature Methods, 9, 676–682. doi: 
10.1038/nmeth.2019. [PubMed: 22743772] 

Sun WC, Gee KR, Klaubert DH, & Haugland RP (1997). Synthesis of fluorinated fluoresceins. Journal 
of Organic Chemistry, 62, 6469–6475. doi: 10.1021/jo9706178.

Voth DE, & Heinzen RA (2007). Lounging in a lysosome: The intracellular lifestyle of Coxiella 
burnetii. Cellular Microbiology, 9, 829–840. doi: 10.1111/j.1462-5822.2007.00901.x. [PubMed: 
17381428] 

Winfree S, & Gilk SD (2017). Quantitative dextran trafficking to the coxiella burnetii parasitophorous 
vacuole. Current Protocols in Microbiology, 46, 6C.2.1–6C.2.12. doi: 10.1002/cpmc.34.

Samanta and Gilk Page 13

Curr Protoc Microbiol. Author manuscript; available in PMC 2023 February 02.

A
uthor M

anuscript
A

uthor M
anuscript

A
uthor M

anuscript
A

uthor M
anuscript



Figure 6C.3.1. 
(A) Representative images of CPVs labeled with Oregon Green and Alexa647 conjugated 

dextrans, treated with ionophores, and bathed in buffers of known pH. Note the decrease 

in Oregon Green fluorescence as the pH becomes more acidic, while Alexa647 remains 

stable. (B) Calibration curve prepared by plotting Oregon Green (488)/Alexa647 fluorescent 

intensity ratio to pH.
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